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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider Windstream and Avaya IP Office 9.0.2 and Avaya
Session Border Controller for Enterprise 6.2.1.

Windstream SIP Trunk Service provides PSTN access via a SIP trunk between the enterprise
and the Windstream network as an alternative to legacy analog or digital trunks. This approach
generally results in lower cost for the enterprise.

Windstream is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Windstream (Broadsoft platform) and an enterprise solution
using an Avaya IP Office Release 9.0.2 and Avaya Session Border Controller for Enterprise (SBCE)
Release 6.2.1. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP
Office 500v2 Release 9.0.2, Avaya embedded Voicemail, Avaya IP Office Softphone, Avaya H.323,
Avaya 1140E SIP, Avaya Flare® Experience for Windows, digital and analog endpoints.

The Windstream SIP Trunk Service referenced within these Application Notes is designed for
business customers. The service enables local and long distance PSTN calling via standards-based
SIP trunks as an alternative to legacy analog or digital trunks, without the need for additional TDM
enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office and
SBCE connecting to Windstream using SIP Trunk Service. This configuration (shown in Figure 1)
was used to exercise the features and functionality tests listed in Section 2.1. Note: NAT devices
added between SBCE and the Windstream network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site was connected to Windstream SIP Trunk Service. To verify SIP trunking
interoperability, the following features and functionality were exercised during the interoperability
compliance test:

e SIP OPTIONS queries to and responses from the service provider.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

¢ Inbound and outbound PSTN calls from/to the Avaya IP Office Softphone, and Avaya
Flare® Experience for Windows.

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international call, outbound toll-free,
operator assisted call, 411 and 911 services.

e Codec G.729A and G.711U.
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Caller number/ID presentation.

Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, forward and conference.

G.711 pass-through fax.

Twinning to mobile phones on inbound calls.

Items not supported or not tested included the following:

Windstream Lab environment does not support T.38 faxing though it is supported in
Windstream production environment.

Windstream Lab environment does not support the inbound-toll-free call though it is
supported in Windstream production environment.

Windstream support registration or non-registration according to the customer or vendor
requirement. This test was made as non-registration SIP Trunking.

The Remote Worker is not tested due to the setup is not available in DevConnect Lab at the
current time of this testing.

2.2. Test Results

The objectives outlined in Section 2.1 were verified. All the applicable test cases were executed.
However, the following observation was noted during the compliance testing:

Call Forward to international numbers does not work properly - Windstream supports
Call Forward to any numbers; US or international. But in this compliance testing,
Windstream only supports Call Forward to US numbers. Call Forward to international
numbers is not allowed because the route to the international test carrier is not working
properly in current Windstream Lab environment.

Blind Call Transfer to PSTN using Avaya 1140E SIP phone does not complete until
transferee picks up the call — Call scenario is when PSTN phone calls to Avaya 1140E SIP
phone, Avaya 1140E SIP phone answers the call and performs blind transfer to another
PSTN endpoint. The expected behavior of Avaya 1140E SIP phone is after transfer, the
phone should display “transfer completed”. But in this case, user presses “transfer” button,
answers question of “Consultative transfer with party ?”” with “No”, which implies the blind
transfer, as the transferee PSTN phone is ringing, the Avaya 1140E SIP phone should be
released and display “transfer successfully”. Instead, the Avaya 1140E SIP phone still
displays “transferring” and not released until the transferee PSTN phone answers the call.
The work around is to hang up the Avaya 1140E SIP phone. This is very minor known
limitation on Avaya 1140E SIP phone. There is no user impact. Transfer is still completed
with 2 way speech paths.
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2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on the Windstream SIP Trunk Service, please contact customer service or visit
http://www.windstream.com/

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to Windstream SIP Trunk Service through the public IP network. For confidentiality and
privacy purposes, actual public IP addresses used in this testing have been masked out and replaced
with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VVolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to internal interface of SBCE.
Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), an Avaya 1100 Series
IP Telephone (with SIP firmware), an Avaya 1408D Digital Telephones, an Avaya Analog
Telephone, Avaya Flare® Experience for Windows and an Avaya IP Office Softphone H.323. A
separate Windows XP PC runs Avaya IP Office Manager to configure and administer Avaya IP
Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with Windstream SIP Trunk Service

For the purpose of the compliance test, Avaya IP Office users dialed a short code of 5 + N digits to
send digits across the SIP trunk to Windstream SIP Trunk Service. The short code of 5 was stripped
off by Avaya IP Office but the remaining N digits were sent unaltered to Windstream SIP Trunk
Service. For calls within the North American Numbering Plan (NANP), the user would dial 11 (1 +
10) digits. Thus for these NANP calls, Avaya IP Office would send 11 digits in the Request URI and
the To field of an outbound SIP INVITE message. It was configured to send 10 digits in the From

field. For inbound calls, Windstream SIP Trunk Service sent 10 digits in the Request URI and the To
field of inbound SIP INVITE messages.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the SBCE such as a data firewall. A complete
discussion of the configuration of these devices is beyond the scope of these Application Notes.
However, it should be noted that SIP and RTP traffic between the service provider and the SBCE
must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components
Equipment Release
Avaya IP Office 500v2 9.0.2.0 (Build860)
Avaya IP Office DIG DCPx16 V2 9.0.2.0 (Build860)
Avaya IP Office Ext Card Phone 8 9.0.2.0 (Build860)
Avaya IP Office Manager 9.0.2.0 (Build 860)
Avaya Session Border Controller for 6.2.1 Q07
Enterprise
Avaya 9640G IP Telephone (H.323) S3.2
Avaya 1140E IP Telephone (SIP) 04.04.10.00
Avaya Digital Telephone (1408D) N/A
Avaya Symphony 2000 Analog N/A
Telephone
Avaya IP Office Softphone 3.2.3.49 68975
Avaya Flare® Experience for Windows 1.1.4.23 SP4
HP Officejet 4500 (fax) N/A
Windstream Components
Equipment Release
Broadsoft 17sp4
Acme Packet Net-Net 4250 SC6.2.0 Patch 3

Note: Testing was performed with IP Office 500 v2 R9.0.2, but it also applies to IP Office Server
Edition R9.0.2. Note that IP Office Server Edition requires an Expansion IP Office 500 v2 R9.0.2 to
support analog or digital endpoints or trunks. IP Office Server Edition does not support TAPI Wave
or Group Voicemail.

5. Configure IP Office

This section describes the Avaya IP Office configuration to support connectivity to SBCE. Avaya IP
Office is configured through the Avaya IP Office Manager PC application. From a PC running the
Avaya IP Office Manager application, select Start - Programs - IP Office > Manager to
launch the application. Navigate to File > Open Configuration, select the proper Avaya IP Office
system from the pop-up window, and log in with the appropriate credentials. A management window
will appear, and the appearance of the IP Office Manager can be customized using the View menu.
In the screens presented in this section, the View menu was configured to show the Navigation pane
on the left side, the Group pane in the center, and the Details pane on the right side. These panes will
be referenced throughout the Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
the LAN interface to the enterprise site and IP Office Softphone support) is assumed to be already in
place.
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5.1. LAN2 Settings

In the sample configuration, IPOffice_1 was used as the system name and the LANZ2 port was used
to connect to internal interface of SBCE. To access the LANZ settings, first navigate to System (1)
- IPOffice_1 in the Navigation and Group Panes and then navigate to the LAN2-> LAN Settings
tab in the Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office
LAN port. Set the IP Mask field to the mask used on the public network. All other parameters
should be set according to customer requirements.

R BOOTP (8) Name System | LaN1 |[LANZ| |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | vCM | CCR | Codecs
4/ Operator (3) “= IPOffice_1 = -
v |IPOFfice_1 LAN Settings| | yoIP | Network Topology
3 [System (1
4 Line (3) IP Address | 10 10 98 14
= Control Unit (4) 1P Mask |2s5 . 255 . 255 . 0
& Extension (29)
§ user(en) Primary Trans. IP Address 0 0 0 0
% Group (1)
9% Short Code (60) Firewall Profile | <None> v
@ service ) RIP Mode |none v
o RAS (1)
€ Incoming Call Route (4) [] Enable NAT

£ wanPort (0)
@ Directory (0)
£ Time Profile (0) DHCP Made

% :::v;z!:z;;ﬂe () O server O client O Dislin (@ Disabled

&m Account Code (0)
. License (30)

@& Tunnel (0)

§5 User Rights (10)
188 Auto Attendant (0)
‘K ARS (2)

& Location (0)

Number Of DHCP IP Addresses 200

ok [ concel [ hep |

Figure 2 — LAN 2 Settings
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Select the Vol P tab as shown in the following screen. The H323 Gatekeeper Enable box is checked
to allow the use of Avaya IP Telephones using the H.323 protocol, such as the 9600-Series IP
Telephones used in the sample configuration. The SIP Trunks Enable box must be checked to
enable the configuration of SIP trunks to SBCE. The SIP Registrar Enable box is checked to allow
Avaya IP Office Softphone usage. The Layer 4 Protocol use UDP with port 5060 and TCP with
port 5060. The RTP Port Number Range can be customized to a specific range of receive ports for
the RTP media. Based on this setting, Avaya IP Office would request RTP media be sent to a UDP
port in the configurable range for calls using LAN2. The Enable RTCP Monitoring on Port 5005
is checked. The specific values used for the compliance test are shown in the example below. All
other parameters should be set according to customer requirements.

=] IPOffice_1 g -8 | X|v|<]

System | LaN1 | |LANZ| |DNS || voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | vcM | CcR | Codecs

| LAN Settings Metwork Togolqg}{ =
A~
l H323 Gatekeeper Enable ‘ s
[[] Auto-create Extn Auto-create User [[] H323 Remate Extn Enable

SIP Trunks Enable

SIP Registrar Enable

Auto-create ExtnfUser [[] sIP Remote Extn Enable
Domain Name
UDP UDP Port 5060 3| RemoteuppPart |
Layer 4 Protocol TCP TCP Port 15050 2| Remote TCP Port |
O s TLSPort |S061 % Remote TLSPort ,
Challenge Expiry Time (secs) 10 7: ]

RTP
Port Number Range

Minimurn 49152 3| Maximurm :53246 -

¥

Port Mumber Range (NAT)

Minimum 49152 | Maximum S3246 &

. 3

l Enable RTCP Monitoring on Port SODSJ
<

Figure 3— LAN 2 VolP Configuration
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On the Network Topology tab in the Details Pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set the Binding Refresh Time (seconds) to 60. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service

provider.

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port.
e Set Public Port for UDP as 5060.
e All other parameters should be set according to customer requirements.

LAN Settings | VoIP | |Metwork Topology

IPOffice_1* s | X | & | < |

System | LAM1 | |LANZ| |DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | ¥CM | CCR | Codecs

Metwork Topology Discovery

[] rRun STUN on startup

STUN Server Address |192.168.10.13 | STUNPort (3478 v
Firewall{NAT Type ;ﬁ)’pen Internet v;
Binding Refresh Time (seconds) 60 3 |
Public IP Address [10 . 10 . 9% . 14 Cancel
Public Port
LIDP 5060 3
TCP 0 L :
TLS o v

Figure 4 — LAN 2 Network Topology Configuration

In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANL1 interface configuration is not directly relevant to the interface with
Windstream SIP Trunk Service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to System (1) > IPOffice_1 in the Navigation and Group Panes and then navigate to the
Telephony = Telephony tab in the Details Pane. Choose the Companding Law typical for the
enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the service
provider across the SIP trunk. Set Hold Timeout (secs) to 600.

£ IPOffice_1* i -8 | X | v <]

System | LANI I LANZ iDNS i‘ Yoicemail | [Telephony »Directory Services I System Events | SMTP I SMDR rTwinning {l VM VCCR I Codecs
|| Telephony| | Park & Page | Tones &Music | Ring Tones | SM | Call Log | TUI

~
Analogue Extensions -
I = Switch Line
Default Outside Call Sequence | Mormal v |
Default Inside Call Sequence {Ring Type 1 v © U-taw © U-Law Line
Default Ring Back Sequence :Ring Type 2 v :
= = O A-Law O A-Law Line
Restrict Analogue Extension Ringer Yoltage O
Dial Delay Time {secs) 4 e, } [] pss Status
Dial Delay Count b & Aol
Default Mo Answer Time (secs) |15 & ‘ Dial By Name
‘ Hold Timeout (secs) 5500 = ' SHaw fccounk: Code
T b B ] tnhibit OFf-Switch Forward/Transfer |
ark Timeout {secs s v
Ring Delay ) 5 : .\” D Restrict Metwork Interconnect
ing Delay (secs 3 v

= [] prop External Only Impromptu Conference

Call Priority Promotion Time {secs) DlsabIEdi =)
as ey [] wisually Differentiate External Call
Default Currency |UsSD v
== = [] unsupervised analog Trunk Disconnect Handling
Default Name Priority | Favor Trunk v
S — — High Quality Conferencing
Media Connection Preservation | Disabled v
[[] strict s1PS
Digital/Analogue Auto Create User
X |
[ QK ] [ Cancel ] [ Help
Figure 5 — Telephony Configuration
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5.3. System Codec Settings

Navigate to System (1) > IPOffice_1 in the Navigation and Group Panes and then navigate to the
Codecs tab in the Details Pane. Choose the RFC2833 Default Payload as IP Office default of 101.
Select codecs G.729(a) 8K CS-ACELP and G.711 ULAW 64K that Windstream SIP Trunk

Service support.

RFC2833 Default Payload

Available Codecs

|[@] G.711 ULAw 64k

[[¥] G.711 ALaw 64K

| 6.722 64K

\[¥] G.729(a) 8K CS-ACELP
\[¥] G.723.1 K3 MP-MLQ

IPOffice_1 5
| System | LAN1 | LAMZ | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR || Twinning | ¥CM | CCR 7;37
for @
Default Codec Selection
Unused Selected
G.711 ALAW 64K ‘ >> | G.729(a) 8K CS-ACELP |

G.723.1 6K3 MP-MLQ | G.711 ULAW 64K

HV; Reviewed:
SPOC 6/10/2014

Figure 6 — Codec Configuration
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5.4. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller ID parameter on the SIP Line form (shown in Section 5.5).

If Send original calling party information for Mobile Twinning on the Twinning tab is optioned,
the setting of the second parameter is ignored and Avaya IP Office will send the following in the SIP
From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party

number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the System—>Twinning tab was unchecked. The value sent in the SIP From header is
determined by the setting of the Send Caller ID parameter on the SIP Line form.

IPOffice_1

| system | LaN1 | LAN2 | DNS | voicemail | Telephony | Directory Services | System Events | sMTp | sMDR |[Twinning || vem | ccR | Codecs|

I [] send original calling party information For Mobile Twinning I

Calling party information for
Mobile Twinning

Figure 7 — Mobile Twinning Configuration
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5.5. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and SBCE. To create
a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the Group
Pane and select New > SIP Line (Not Shown). On the SIP Line tab in the Details Pane, configure
the parameters as shown below:

Set ITSP Domain Name to the enterprise domain so that IP Office uses this domain as the
host portion of the SIP URI in SIP headers such as the From header.

Check the In Service box.

Set URI Type to SIP.

Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

Set Call Routing Method to Request URI.

Check Caller ID from From header box.

Set Send Caller ID to Diversion Header. For the compliance test, this parameter was used
for call forwarding and it was used in Mobility Twinning since Send original calling party
information for Mobile Twinning is not optioned in Section 5.4.

Set Association Method to By Source IP address.

Set Service Busy Response as 503 - Service unavailable.

Check REFER Support to enable SIP REFER for call transfers. Select the default values of
“Auto” for Incoming and Outgoing to use of SIP REFER effectively.

Set Method for Session Refresh to Reinvite with Session Timer (seconds): 1200. If the
Method for Session Refresh set to the default value “On Demand”, then IP Office does not
initiate Session Timer and only supports it if it is initiated by the other side.

Default values may be used for all other parameters.
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IP Offices SIP Line - Line 17 &
@-R BOOTP (5) SIP Line| Transport|SIP URI|VolP |38 Fax|SIP Credentials
B4 Oi erator I3)
= *v Line Number 17 =
(-3 System (1)
=] {—':, |n5p Domain Name 10.10.97.174 | |ln Service ml
o 1
- 2 I URI Type [sm .]
. ",
(<= Control Unit (4) Prefix | Check 00S |
(-4 Extension (28)
@@ User(26) National Prefix Call Routing Method [Request URI V]|
(-5 Group (1) Origi
ginator number for
L 3 zzoftc:‘(’;e (60) Country Code forwarded and twinning calls
i
ol RAS (1) International Prefix Name Priority ISyslem Default vl
2] e Incoming Call Route (6) —
-9 WanPort (0) ISend Caller ID [Diversion Header VJ ICBHEV ID from From header M]|
@ Directory (0)
£1) Time Profile (0) | Association Method [By Source IP address V] Send From In Clear B
&3] Firewall Profile (1) User-Agent and Server
3] IP Route (3) Headers
@8 Account Code (0)
- License (30) Service Busy Response [503 - Service Unavailable V] |
¥ Tunnel (0) . T
#-§3 User Rights (10) Action on CAC Location Limit LAIIC’W Voicemail ,J
@8 Auto Attendant (0)
G ARS Q) [¥] REFER Support
-i8 Location (0) Incoming [Auto ']
Outgoing [Auto ']
Method for Session Refresh [Reinvite VI
Session Timer (seconds) 1200 E
Media Connection Preservation [Disabled ']
Figure 8 — SIP Line Configuration
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Select the Transport tab. The ITSP Proxy Address is set to the SBCE internal IP address. As
shown in Figure 1, this IP address is 10.10.97.174. In the Network Configuration area, UDP is
selected as the Layer 4 Protocol, and the Send Port is set to the port number using on SBCE, in this
case the well-known SIP port of 5060 was used. The Use Network Topology Info parameter is set
to LAN 2. This associates the SIP Line with the parameters in the System - LAN2 - Network
Topology tab. Other parameters retain default values in the screen below.

“33’ SIP Line -Line 17*

|SIP Line|Transport| SIP URI|VolP | T38 Fax|SIP Credentials

ITSP Proxy Address 10.10.97.174

Network Configuration

Layer 4 Protocol [UDP v] Send Port 5060 =
Use Network Topology Info ILAN 2 v} 5060

Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar  [V]

Separate Registrar

Figure 9 — SIP Line Transport Configuration
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane (Not shown). To edit an existing entry, click an entry in the list at the top, and
click the Edit... button. In the example screen below, a previously configured entry is edited. For
the compliance test, a single SIP URI entry was created that matched any DID number assigned to
an Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, and Display Name to Use Internal Data. This setting allows calls
on this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.7.

e Set PAI to Use Internal Data. With this setting IP Office will populate the SIP P-Asserted-
Identity header on outgoing calls with the data set in the SIP tab of the call initiating User as
shown in Section 5.7.

e Set Registration to 0: <None> since Windstream SIP Trunk service does not require
registration.

e Associate this line with an incoming line group in the Incoming Group field. This line group
number will be used in defining incoming call routes for this line. Similarly, associate the
line to an outgoing line group using the Outgoing Group field. For the compliance test, a
new incoming and outgoing group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.
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B SIP Line - Line 17

'SIP Line| Transport [SIP URI| volp | 138 Fax|SIP Credentials

Channel  Groups Via Local URI Contact Display Name = PAI | add...
1 17 17 15
Remove
Edit...
Edit Channel
QK
Via 110.10.98.14 | ——
= = = 7 Cancel
Local URI hse Internal Data v
Contact iUse Internal Data v ‘
Display Name msei Internal Data v \
PAI {Use Internal Data v f
Registration i}D: <None > v
Incoming Group [1 7 {
QOutgoing Group ii? .
Max Calls per Channel flU =
Figure 10 — SIP Line SIP URI Configuration
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. Selecting G.729(a) 8K CS-
ACELP and G.711 ULAW 64K codecs causes Avaya IP Office to include these codecs,
which are supported by the Windstream SIP Trunk Service, in the Session Description
Protocol (SDP) offer, in that order.

e Uncheck the VoIP Silence Suppression box.

e Check the Re-invite Supported box.

e Check Codec Lockdown.

e Set Fax Transport Support to G.711 from the pull-down menu since Windstream supports
G.711 pass-through fax.

e Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

7 SIP Line - Line 17*
ElpiLinie}'Franspo?t]glP URI‘ VoIP ;‘T38 Fa;]gIP Credentialis{‘
l [] VoIP Silence Suppression
[7] Allow Direct Media Path
Codec Selection ‘Custom " [¥] Re-invite Supported
Unused Selected b
|| Codec Lockdown
G.711 ALAW 64K Sy (G.729(a) 8K CS-ACELP
G.723.1 6K3 MP-MLQ G.711 ULAW 64K [] PRACK/100rel Supported
Force direct media with phones
[7] G.711 Fax ECAN
Fax Transport Support [G.711 VI '
Location [Cloud v‘
Call Initiation Timeout (s) |4 S
DTMF Support [RFC2833 v

Figure 11 — SIP Line VolP Configuration
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5.6. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation Pane, then right-click in the Group Pane and select New (Not Shown).
On the Short Code tab in the Details Pane, configure the parameters for the new short code to be
created. The screen below shows the details of the previously administered “5N;” short code used in
the test configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 5N;, this short code will be invoked when the user dials 5 followed by
any number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to N“@10.10.97.174”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the domain of the service
provider network.

e Setthe Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5. This short code will use this line group when placing the outbound call.

IP Offices | Short Code 7 5N;: Dial*
R BOOTP (5) Code Telephone Number Feature Line GroupID  * |||[Short Code
i 3> o(5N;]  N'@101097174"  Dial 17
RS IIPO;ﬁcte_l & BX6N N Dial 50: Main Code 5N;
% System >
7 Line @) BXFNEOD 00 FNE Service 0 Featire (il =
<< Control Unit (4) = ~
& Extension (28) Telephone Number  N"@10.10.97.174
!‘ﬂ lGJ::LE)Z?I)] Line Group ID lﬂ -
g zh"'.t C‘(’(;’]E ©0) Locale United States (US English) v
ervice
o RAS (1) Force Account Code [

@ Incoming Call Route (6)

Figure 12 — Short Code 5N Configuration
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The simple “5N;” short codes illustrated above does not provide a means of alternate routing if the
configured SIP Line is out of service or temporarily not responding. When alternate routing options
and/or more customized analysis of the digits following the short code are desired, the Automatic
Route Selection (ARS) feature may be used. In the following example screen, the short code 6N is
illustrated for access to ARS. When the Avaya IP Office user dials 6 plus any number N, rather than
being directed to a specific Line Group ID, the call is directed to Line Group ID 50: Main,
configurable via ARS. See Section 5.9 for example ARS route configuration for 50: Main as well as
a backup route.

= 6N: Dial
Code 6N
Feature [Dial v

Telephone Number N

Line Group ID 50: Main o

Locale United States (US English) =

Force Account Code [

Figure 13 — Short Code 6N Configuration

The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by IP Office. The Short Code FNEOO was configured with following
parameters:

For Code field, enter FNE feature code as FNEOQO for dial tone.

Set Feature to FNE Service.

Set Telephone Number to 00.

Set Line Group ID to 0.

Default values may be used for other parameters.

= FNEOO: FNE Service

Code FNEQO

Feature I FNE Service v

Telephone Number 00

Line Group ID 0 v

Locale United States (US English) v

Force Account Code [}

Figure 14 — Short Code FNEOO Configuration
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 9305. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.5). The
example below shows the settings for user 9305. The SIP Name and Contact are set to one of the
DID numbers assigned to the enterprise provided by Windstream SIP Trunk Service. The SIP
Display Name (Alias) parameter can optionally be configured with a descriptive name. If all calls
involving this user and a SIP Line should be considered private, then the Anonymous box may be
checked to withhold the user’s information from the network.

IP Offices | User £ 9305: 9305 IR
/xl (B)Og;fo?(]g) Nae Extension ‘"Dialln Voice Recording | Button P 9r i g I Menu P 9r i e | Mobility | Group Memhers!;}; Announcem;sm ”I;ersonalsi;ectory
= “‘1‘ = g,, SIP Name 7133439305

%7 System "

7 Line @) drFAX 9307 207 SIP Display Name (Alias) 9305

“= Control Unit (4) fNoUser

& Extension (28) frgRemoteManager Contact 7133439305

i

a'“ Group (1)

8% Short Code (60) | Anonymous

D Service (0)

Figure 15 — User Configuration
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User 9305. The Mobility Features and Mobile Twinning boxes
are checked. The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 51613970 XXXX. Check Mobile Call Control to allow
incoming calls from mobility extension to access FNEOO (see Section 5.6). Other options can be set
according to customer requirements.

g 9305: 9305* o

( Dial In I Voice Recording | Button Programming I Menu Programming i IMObi“'f)’l ! Group Membership | Announcements I SIP IE

[T] Internal Twinning

<None>

Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

l’j} Mobility Features|
|@ Mobile Twinningl

Twinned Mobile Number
(including dial access code)

51613970X0CKX

Twinning Time Profile <None> v

Mobile Dial Delay (secs) 2

-

Mobile Answer Guard (secs) 0

[] Hunt group calls eligible for mobile twinning
[] Forwarded calls eligible for mobile twinning
[7] Twin When Logged Out

[7] one-X Mobile Client

v

Mobile Call Control

7| Mobile Callback

Figure 16 — User Mobility Configuration
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5.8. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.

e Set the Incoming Number to the incoming number on which this route should match.

e Default values can be used for all other fields.

IP Offices | Incoming Call Route = 17 7133439305
8 BOOTP (5) Line GroupID  Incoming Number 75tandafd7TVoice Recording ] Destination;i
g 3J @17 7133439306
IPOfo;fe; i 17 7133439305 N _
T". Line 3) 1 7133439307 Bearer Capability [Any Voice v
= Control Unit (4) Line Group ID 17 2
4 Extension (28)
@ User (26) Incoming Number 7133439305
438 Group (1)
--@% Short Code (60) Incoming Sub Address
Service (0

g ReAr;xcle( ) Incoming CLI
~§P|Incoming Call Route (6) ey [ 'J
4@ WanPort (0)

ﬁ_f Directory (0) Priority [1 - Low 'J
=17 Time Profile (0)
@@ Firewall Profile (1) Tag

[l P Route (3)
- Account Code (0) Hold Music Source [System Source "
-8 License (30) ! . v
@& Tunnel () Ring Tone Override one %

Figure 17 — Incoming Call Route Configuration 1

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 7133439305 on line 17 are routed to extension 9305 9305.

x

= 17 7133439305 ek - X|wvl <l
‘ Standard I Voice Recording | | Destinations ‘

TimeProfile Destination Fallback Extension ‘

b | Default Value 9305 9305 =] =]

Figure 18 — Incoming Call Route Configuration 2
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Note: The same DID number 7133439307 was changed between two destinations (FNEOO and
Voicemail) during testing.

The incoming calls to DID number 7133439307 were configured to access FNEOQO. The Destination
was appropriately defined as FNEQO as below screenshot:

7 17 7133439307* ek -8 X v|<
Standard i Voice Recording ‘

‘ TimeProfile Destination Fallback Extension
> Default Value GENED = |vl

Figure 19 — Incoming Call Route Configuration 3

The incoming calls to DID number 7133439307 were configured to access VVoiceMail. The
Destination was appropriately defined as VVoiceMail as below screenshot:

7 17 7133439307 ef - ¥ | i

Standard i Voice Recording

TimeProfile Destination Fallback Extension

N Default Value

Figure 20 — Incoming Call Route Configuration 4

5.9. ARS and Alternate Routing

While detailed coverage of Automatic Route Selection (ARS) is beyond the scope of these
Application Notes, this section includes basic ARS screen illustrations and considerations. ARS is
shown here mainly to illustrate alternate routing should the SIP Line be out of service or temporarily
not responding.

Optionally, ARS can be used rather than the simple 5N; short code approach documented in Section
5.6. With ARS, a secondary dial tone can be provided after the access code, time-based routing
criteria can be introduced, and alternate routing can be specified so that a call can re-route
automatically if the primary route or outgoing line group is not available. Although not shown in this
section, ARS also facilitates more specific dialed telephone number matching, enabling immediate
routing and alternate treatment for different types of numbers following the access code. For
example, if all 1+10 digit calls following an access code should use the SIP Line preferentially, but
other local or service numbers following the access code should prefer a different outgoing line
group, ARS can be used to distinguish these call behaviors.

To add a new ARS route, right-click ARS in the Navigation pane, and select New (Not Shown). To
view or edit an existing ARS route, select ARS in the Navigation pane, and select the appropriate
route name in the Group pane.
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The following screen shows an example ARS configuration for the route named Main. The In
Service parameter refers to the ARS form itself, not the Line Groups that may be referenced in the
form. If the In Service box is un-checked, calls are routed to the ARS route name specified in the
Out of Service Route parameter. IP Office short codes may also be defined to allow an ARS route
to be disabled or enabled from a telephone. The configurable provisioning of an Out of Service
Route, and the means to manually activate the Out of Service Route can be helpful for scheduled
maintenance or other known service-affecting events for the primary route.

IP Offices ARS Ei Main® ek-B X[ v <]

R B0OTP (8) Name: Time Profile e
¢ Operator (3) "¢ backyp =
“ay IPOffice_1 ARS Route Id | Secondary Dial tone

3 System (1)

4 Line (3) Raute Name | SystemTone v

= Control Unit (4) i

& Extension (29) Dial Delay Time System Default (4) & Check User Call Barring

2 User(2n)

% HuntGroup (1)

9 Short Code (58) In Service Out of Service Route [51: backup vl

@B service (0) =

o RAS (1) 1

@ Incoming Call Route (4) . )

9 wanPort (0) Time Profile ey Ot of Hours Route <None> v

e Directory (0) l

£ Time Profile (0)

@ Firewall Profile (1)

B P Rovte (3) Code Telephone Number Feature Line Group ID

am Account Code (0) 1 911 Dial Emergency 0

. License (30) 911 911 Dial Emergency 0 Bemcks

W Tunnel (0) on; o Dial 31 [ =

§5 User Rights (10) in; IN'10.10,98,14" Dial 3K1 17

18 Auto Attendant (0) 0 N Dial 3K1 0

|ARS (2) KXXAXKKXKKN N Dial 3K1 0

§x ES11 System (1)

Alternate Route Priority Level |3 v l
alternate Route Wait Time 30 $ | e} Alternate Route 51: backup v| 2
ot oo I b ]

Figure 21 — Main ARS

Assuming the primary route is in-service, the number passed from the short code used to access ARS
(e.g., 6N in Section 5.6) can be further analyzed to direct the call to a specific Line Group ID. Per
the example screen above, if the user dialed 6-1-613-967-5205, the call would be directed to Line
Group 17, the SIP Line configured and described in these Application Notes. If Line Group 17
cannot be used, the call can automatically route to the route name configured in the Additional
Route parameter in the lower right of the screen. Since alternate routing can be considered a
privilege not available to all callers, IP Office can control access to the alternate route by comparing
the calling user’s priority to the value in the Alternate Route Priority Level field.
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The following screen shows an example ARS configuration for the route named backup with ARS
Route Id 51. Continuing the example, if the user dialed 6-1-613-967-5205, and the call could not be
routed via the primary route 50: Main described above, the call will be delivered to this backup
route. Per the configuration shown below, the call will be delivered to Line Group 0, using an
analog/PRI trunk connecting the Avaya IP Office to the PSTN as a backup connection. In this case,
the originally dialed number (sans the short code 6) will be dialed as is through the analog/PRI trunk
to the PSTN.

B backup ek -B X vl<]>

ARS

IP Offices

R BOOTP (8)
¢ Operator (3)
= IPOffice_1

3 System (1) r -
17 Line (3) Route Name backup Systemrone 5
“= Control Unit (4)
& Extension (29) Dial Delay Time System Default (4) 5 Check User Call Barring
§ Useri2n T
&% HuntGroup (1)
9 Short Code (58) In Service Out of Service Route [ <none> v
@ service (0) 2

Time Profile

ARS Route Id E Secondary Dial tone ~

o RAS (1) l
€ Incoming Call Route (4)
£ wanPort (0) Time Profile e QUL 0f Hours Route | <None> v
2 Directory (0) l
17 Time Profile (0)
g ::;ﬁz!: Eg;‘le @ Code Telephone Number Feature Line Group ID
&m Account Code (0) 11 911 Dial Emergency 0
W, License (30) 911 311 Dial Emergency 0 Remove
@ Tunnel (0) n N Dial 0 7
§3 User Rights (10)
8 Auto Attendant (0)
‘rlars 2]
fix E911 System (1)
|

e} Alternate Route | <hone> v 3

Help

Figure 22 — Backup ARS

In the testing associated with the configuration, calls were successfully delivered to SIP Line 17 via

the primary ARS route 50: Main or to the analog/PRI trunk via the backup ARS route shown above.
When the primary route experiences a network outage, Avaya IP Office successfully routed the call

via the backup route.

5.10. Save Configuration

Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Configure Session Border Controller for Enterprise
This section describes the configuration of SBCE necessary for interoperability with the Avaya IP
Office and Windstream SIP Trunk Service.

Avaya elements reside on the Private side and the Windstream SIP Trunk Service resides on the
Public side of the network, as illustrated in Figure 1.

Note: The following section assumes that SBCE has been installed and that network connectivity
exists between the systems. For more information on SBCE, see Section 10 of these Application
Notes.

6.1. Log into the SBCE

Access the web interface by typing “https://x.x.x.x/sbc/” (where x.x.x.x is the management IP of the
SBCE).

Enter the Username and Password.

AVAYA ==

'Passwordj |oooooooooooooo l

LogIn |

Session Border Contro”er This system is restricted solely to authorized users for legitimate
= business purposes only. The actual or attempted unauthorized access,
for Enterprise

use or modifications of this system is strictly prohibited. Unauthorized
users are subject to company disciplinary procedures and or criminal
and civil penalties under state, federal or other applicable domestic and
foreign laws.

The use of this system may be monitored and recorded for
administrative and security reasons. Anyone accessing this system
expressly consents to such monitering and recerding, and is advised
that if it reveals possible evidence of criminal activity, the evidence of
such activity may be provided to law enforcement officials.

All users must comply with all corporate instructiens regarding the
protection of information assets.

® 2011 - 2013 Avaya Inc. All rights reserved.

Figure 23 - SBCE Login
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6.2. Global Profiles
When selected, Global Profiles allow for configuration of parameters across all SBCE appliances.

6.2.1. Configure Server Interworking - Avaya site

Server Interworking allows one to configure and manage various SIP call server-specific capabilities
such as call hold, 180 handling, etc.

From the menu on the left-hand side, select Global Profiles > Server Interworking - Add
e Enter Profile name: IPO_14
e On the General tab, all options can be left at default.

On the Timers, URI Manipulation, Header Manipulation and Advanced tabs: All options can be
left at default. Click Finish (not shown).

The following screen is shown that Avaya IP Office interworking (named: 1PO_14) was added.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: IPO_14
eSO Add [ Rename || Clone H Delete ‘
Backup/Restore .
Click here to add a description.
System Management T
Cs.
Global Parameters ‘General||| Timers || URI Manipulati || Header Manipulati H Ady d |
4 |Global Profiles avayatu
- General A
Domain DoS 0OCS-Edge-Server Hold Support NONE
Fingerprint HSEOCHR )
Server Interworking 180 Handing Nane
cups .
Phone Interworking 181 Handling None
Media Forking SiperziHalo 182 Handling None
Routing OCS-FrontEnd-Server 183 Handling None
S Configurati
SIVED on.lg.ura on Refer Handling No
Topology Hiding
Signaling Manipulation LRl Grow: Nons
URI Groups 3xx Handling No
SIP Cluster Diversion Header Support No
Domain Policies Delayed SDP Handling No
TLS Management
’ 3 5 Re-Invite Handling No
Device Specific Settings
T.38 Support No
URI Scheme SIP
Via Header Format RFC3261
Privacy Enabled No
User Name
P-Asserted-Identity No
P-Preferred-Identity No
Privacy Header v
Figure 24 - Server Interworking — Avaya site
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6.2.2. Configure Server Interworking — Windstream site

From the menu on the left-hand side, select Global Profiles - Server Interworking - Add
e Enter Profile name: SP3
e All options on the General tab can be left at default.

On the Timers, URI Manipulation, Header Manipulation and Advanced tabs: All options can be
left at default. Click Finish (not shown).

The following screen is shown that Windstream server interworking (named: SP3) was added.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: SP3
Acminisiration Add | Rename || Clone H Delete ‘
Backup/Restore .
System Management o0
Cs.
Global Parameters |General||| Timers || URI Manipulati || Header Manipulati H Ad: = |
4 |Global Profiles avayaiu
- General A
Domain DoS 0OCS-Edge-Server Hold Support NONE
Fingerprint iSCO-
- fecocem 180 Handling None
Server Interworking
cups 5
Phone Interworking 181 Handiing None
Media Forking Siperactialo 182 Handling None
Routing OCS-FrontEnd-Server 183 Handling None
S Configurat
erver on‘lg-ura < e Refer Handling No
Topology Hiding PO 14
Signaling Manipulation ~ Uil Grote Rogo
URI Groups 3xx Handling No
SIP Cluster Diversion Header Support No
Domain Policies Delayed SDP Handling No
TLS Management
i ; . Re-Invite Handling No
Device Specific Settings
T.38 Support No
URI Scheme SIP
Via Header Format RFC3261
Privacy Enabled No
User Name
P-Asserted-Identity No
P-Preferred-ldentity No
Privacy Header 4
Figure 25 - Server Interworking — Windstream site
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6.2.3. Configure URI Groups

The URI Group feature allows an administrator to create any number of logical URI groups that are
comprised of individual SIP subscribers located in that particular domain or group.

The following URI Group configuration is used for this specific testing in the DevConnect Lab
environment. The URI-Group named SP3 was used to match the “From” and “To” headers in a SIP
call dialog received from both Enterprise and Windstream SIP Trunk Service. If there is a match, the
SBCE will apply the appropriate Routing profiles (see Section 6.2.4, 6.2.5), Server Flows (see
Section 6.4.4), and Session Flow (see Section 6.4.5) to route incoming and outgoing calls to the
right destinations. In production environment, there is not a requirement to define this URI.

From the menu on the left-hand side, select Global Profiles > URI Groups. Select Add.

e Enter Group Name: SP3.

e Edit the URI Type: Regular Expression (not shown).

e Add URI: .*10\.10\.97\.174 (SBCE internal interface IP address), .*10\.10\.98\.106 (SBCE
external interface IP address), .*10\.10\.98\.14 (Avaya IP Office LAN2 interface IP address),
*192\.168\.64\.230 (Windstream SIP Signaling server IP address), .*mcleodusa
(Windstream domain), .*nonymous\.invalid (Anonymous URI).

e Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise AVAYA
Dashboard URI Groups: SP3
Administration Add
Backup/Restore
URI Groups Click here to add a description.
System Management TR
tr
Global Parameters sieam URI Group
RC
4| Global Profiles nad
Domain DoS ThinkTel
Fingerprint  URilstng |
) Sk *10110\97\174 Edit Delete
Server Interworking s
Phone Interworking *101.101.981.106 Edit D
Media Forking Emergency #10110198\14 D
Routing 1921168\ 641230 Edit D
Server Configuration — Edit D
Topology Hiding
“nonymous\.invalid Edit Delete

Signaling Manipulation

SIP Cluster
Domain Policies

Figure 26 - URI Group

6.2.4. Configure Routing — Avaya site

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing Profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information, and
packet transport types.
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From the menu on the left-hand side, select Global Profiles > Routing - Add.
Enter Profile Name: To_IPO_14
e URI Group: SP3
Next Hop Server 1: 10.10.98.14:5060 (Avaya IP Office LANZ interface IP address)
Check Routing Priority based on Next Hop Server (not shown)
Outgoing Transport: UDP (not shown)
Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: To_IPO_14
Admitisiation Add [ Rename || Clone H Delete ‘
Backup/Restore .
Click here to add a description.
System Management
default
Global Parameters Routing Profile
Domain DoS
y x URI Group Next Hop Server 1 Next Hop Server 2

Fingerprint

SErveRIREROTRG [1]|sps 10.10.98.14:5060 - View Edit

Phone Interworking

Media Forking

Server Configuration

Figure 27 - Routing to Avaya

6.2.5. Configure Routing — Windstream site
The Routing Profile allows one to manage parameters related to routing SIP signaling messages.

From the menu on the left-hand side, select Global Profiles = Routing - Add.
Enter Profile Name: To_SP3
e URI Group: SP3

e Next Hop Server 1: 192.168.64.230:5060 (Windstream SIP Signaling server IP address)
e Check Routing Priority based on Next Hop Server (not shown)
e Qutgoing Transport: UDP (not shown)
e Click Finish (not shown).
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Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles: To_SP3
Administration

Add l Rename || Clone “ Delete ‘
Backup/Restore

Routing Profiles Click here to add a description.
System Management

default
Global Parameters Routing Profile

4| Global Profiles To_IPO_14 =
Domain DoS --1O SP3
Fingerprint = URI Group Next Hop Server 1 Next Hop Server 2
Server Interworking SP3 192.168.64.230:5060 - View Edit

Phone Interworking
Media Forking

Server Configuration

Figure 28 - Routing to Windstream

6.2.6. Configure Server — Avaya IP Office
The Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. Together, these tabs allow one to configure and manage various SIP call server-specific

parameters such as UDP port assignment, IP Server type, heartbeat signaling parameters and some
advanced options.

From the menu on the left-hand side, select Global Profiles > Server Configuration ->Add.
Enter profile name: IPO_14

On General tab, enter the following:
e Server Type: Select Trunk Server
e [P Address/FQDNs: 10.10.98.14 (Avaya IP Office LAN2 interface IP Address)
e Supported Transports: UDP
e UDP Port: 5060

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IPO_14
Admintiahon Add Rename || Clone ” Delete l
Backup/Restore
[Generar] | Authentcaton | [Heartbeat || Advanced
System Management T B || H | ‘
Global Parameters = Server Type Trunk Server
#|Global Profiles IP Addresses / FQDNs 10.10.98.14
Domain DoS
X i Supported Transports ubP
Fingerprint
Server Interworking Lol 28
Phone Interworking
Media Forking

Routing
Figure 29 — Avaya IP Office General Server Configuration
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On the Advanced tab:
e Select IPO_14 for Interworking Profile

Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: IPO_14
Adminsbation Add Rename || Clone H Delete
Backup/Restore
System Management AR i J H ot | ‘ L | “Adva"cmn
Global Parameters Enable DoS Protection O
4 |Global Profiles E . o
Domain DoS nable Grooming O
Fingerprint Interworking Profile IPO_14‘
Server Interworking Signaling Manipulation Script None
Phone Interworking UDP Connection Type SUBID
Media Forking
Routing Edit
Server Configuration

Figure 30 — Avaya IP Office Advanced Server Configuration

6.2.7. Configure Server — Windstream
From the menu on the left-hand side, select Global Profiles - Server Configuration - Add.

Enter profile name: SP3

On General tab, enter the following:
e Server Type: Select Trunk Server
e IP Address: 192.168.64.230 (Windstream Signaling server IP Address)
e Supported Transports: UDP
e UDP Port: 5060

Alarms  Incidents  Statistics Logs Diagnostics Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP3
Adrmnistition Add Rename H Clone H Delete ‘
Backup/Restore
Server Profiles ‘Genera,m Aithontaars H = Il e =
System Management —
Global Parameters — Server Type Trunk Server
SP3

4 {Clobal Erofiles IP Addresses / FQDNs 192.168.64.230

Domain DoS

. B Supported Transports UDP

Fingerprint

Server Interworking UDEGort 2050

Phone Interworking

Media Forking
Routing

Server Configuration

Topology Hiding

Figure 31 - Windstream General Server Configuration
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On the Advanced tab, enter the following:
e Interworking Profile: select SP3

Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users

Session Border Controller for Enterprise

Dashboard
Administration

Topology Hiding

Server Configuration: SP3

Seftings Help Log Out

AVAYA

Add Rename || Clone H Delete ‘
Backup/Restore
Server Profiles I || Authenticati Heartb Advanced
System Management — J' J ‘ | “ i H
Global Parameters — Enable DoS Protection O
4| Global Profiles SP3
z Enable Groomin,
Domain DoS z J
Fingerprint Interworking Profile SP3 |
Server Interworking Signaling Manipulation Script None
Phone Interworking UDP Connection Type SUBID
Media Forking
Routing Edit
Server Configuration

Figure 32 - Windstream Advanced Server Configuration

On Heartbeat tab, enter the following:
e Check Enable Heartbeat

Method: OPTIONS

Frequency: 60 seconds

From URI: ping@10.10.98.106

To URI: ping@192.168.64.230

Alarms  Incidents  Statistics Logs  Diagnostics  Users
Session Border Controller for Enterprise

Dashboard Server Configuration: SP3

Seftings Help Log Out

AVAYA

Administration

Server Configuration

Topology Hiding

Rename H Clone ” Delete w

Add
Backup/Restore
Server Profiles | l| Authenticati |HHeartbeat]H Advanced |
System Management
IPO_14
Global Parameters |Enable Heartbeat @J
4 [Global Profiles e
. Method OPTIONS
Domain DoS
Fingerprint Frequency 60 seconds
Server Interworking From URI ping@10.10.98.106
Phone Interworking To URI ping@192.168.64.230
Media Forking
Edit
Routing
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Figure 33 - Windstream Heartbeat Server Configuration
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6.2.8. Configure Topology Hiding — Avaya site

The Topology Hiding screen allows one to manage how various source, destination and routing
information in SIP and SDP message headers are substituted or changed to maintain the integrity of
the network. It hides the topology of the enterprise network from external networks

From the menu on the left-hand side, select Global Profiles = Topology Hiding.

Select Add, enter Profile Name: To_IPO_14
e For the Header From,
- Inthe Criteria column select: IP/Domain
- Inthe Replace Action column select: Overwrite
In the Overwrite Value column: 10.10.97.174
e For the Header Request-Line,
- Inthe Criteria column select: IP/Domain
- Inthe Replace Action column select: Overwrite
- In the Overwrite Value column: 10.10.98.14
e For the Header To,
- Inthe Criteria column select: IP/Domain
- Inthe Replace Action column select: Overwrite
In the Overwrite Value column: 10.10.98.14

Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise

Dashboard
Administration
Backup/Restore
System Management

Topology Hiding Profiles: To_IPO_14
Add

Topology Hiding Profiles Click here to add a description.

AVAYA

[ Rename ” Clone H Delete }

default
Global Parameters Topology Hiding
K s i Header Criteria Replace Action Overwrite Value
Pomaintbo> From IP/Domain Overwrite 10.10.97.174
Fingerprint
. Request-Line IP/Domain Overwrite 10.10.98.14
Server Interworking
Phone Interworking To IP/Domain Overwrite 10.10.98.14
Media Forking -Edt
Routing -
Server Configuration
Signaling Manipulation
Figure 34 - Topology Hiding Avaya IP Office
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6.2.9. Configure Topology Hiding — Windstream site
From the menu on the left-hand side, select Global Profiles - Topology Hiding.

Select Add Profile, enter Profile Name: To_SP3

e For the Header From,
- Inthe Criteria column select: IP/Domain
- Inthe Replace Action column select: Overwrite
- In the Overwrite Value column: 10.10.98.106

e For the Header Request-Line,
- Inthe Criteria column select: IP/Domain
- Inthe Replace Action column select: Overwrite
- In the Overwrite Value column: 192.168.64.230

e For the Header To,
- Inthe Criteria column select IP/Domain
- Inthe Replace Action column select: Overwrite
- In the Overwrite Value column: 192.168.64.230

Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Topology Hiding Profiles: To_SP3

Administration Add l Rename || Clone H Delete ‘
Backup/Restore

Topology Hiding Profiles Click here fo add a description.
System Management

default
Global Parameters Topology Hiding
- _ cisco_th_profile
Global Erofiles Header Criteria Replace Action Overwrite Value
i To_IPO_14
RomainDos S From IP/Domain Overwrite 10.10.98.106
Fingerprint To SP3
. Request-Line IP/Domain Overwrite 192.168.64.230
Server Interworking
Phone Interworking To IP/Domain Ovenwrite 192.168.64.230
Media Forking
Edit

Routing

Server Configuration

Topology Hiding

Signaling Manipulation

Figure 35 - Topology Hiding Windstream

6.3. Domain Policies

The Domain Policies feature allows one to configure, apply, and manage various rule sets (policies)
to control unified communications based upon various criteria of communication sessions
originating from or terminating in the enterprise. These criteria can be used to trigger different
policies which will apply on call flows, change the behavior of the call, and make sure the call does
not violate any of the policies. There are default policies available to use, or one can create a custom
domain policy.
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6.3.1. Create Application Rules

Application Rules allow one to define which types of SIP-based Unified Communications (UC)
applications the SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In
addition, one can determine the maximum number of concurrent voice and video sessions so that the
network will process to prevent resource exhaustion.

For the compliance test, the predefined default application rule (shown below) was used for both
Avaya IP Office and the Windstream server.

From the menu on the left-hand side, select Domain Policies - Application Rules.
e Select the default Rule to view.

Alarms  Incidents  Statistics Logs Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Application Rules: default
Administration [Filter By Device... v
Backup/Restore —
Application Rules Itis not recommended to edit the defaults. Try cloning|or.adding a new rule instead.
System Management
efault
Global Parameters Application Rule
default-trunk
Global Brofiles Application Type Out Maximum Concurrent Sessions ~ Maximum Sessions Per Endpoint
SIP Cluster default-subscriber-low
- — Audio v 2000 10
4 default-subscriber-high
Application Rules Video O O
eSE default-server-low
order Rules
g M o O
Media Rules default-server-high
Securty Rules
Signaling Rules CDR Support None
Time of Day Rules RTCP Keep-Alive No
End Point Policy
Groups
Session Policies

Figure 36 — Application Rule

6.3.2. Create Border Rules

Border Rules allow one to control NAT Traversal. The NAT Traversal feature allows one to
determine whether or not call-flow through the DMZ needs to traverse a firewall and the manner in
which pinholes will be kept open in the firewall to accommodate traffic.

For the compliance test, the predefined default border rule (shown below) was used for both Avaya
IP Office and the Windstream server.

From the menu on the left-hand side, select Domain Policies 2> Border Rules.
e Select the default Rule to view.
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Alarms  Incidents  Statistics Logs  Diagnostics  Users

Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Border Rules: default
Administration [Filter By Device vl
Backup/Restore

Itis not recommended to edit the defaults. Try cloning or adding a new rule instead.
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NAT Traversal
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Figure 37 - Border Rule

6.3.3. Create Media Rules

Media Rules allow one to define RTP media packet parameters such as prioritizing encryption
techniques and packet encryption techniques. Together these media-related parameters define a strict
profile that is associated with other SIP-specific policies to determine how media packets matching
these criteria will be handled by the SBCE security product.

For the compliance test, the predefined default-low-med media rule (shown below) was used for
both Avaya IP Office and the Windstream server.

From the menu on the left-hand side, select Domain Policies = Media Rules.
e Select the default-low-med Rule to view.
The Media NAT tab has no entries.
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Figure 38 — NAT Media Rule
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The Media Encryption tab indicates that no encryption was used.
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Figure 39 — Encryption Media Rule

The Media Anomaly tab shows Media Anomaly Detection was disabled.

Media NAT | | Media Encryption | || Media Anomalyl Media Silencing | | Media QoS

Media Anomaly Detection [

Figure 40 — Anomaly Media Rule

The Media Silencing tab shows Media Silencing was disabled.

Media NAT | | Media Encryption | | Media Anomaly | | [Media Silencing| | | Media QoS

Media Silencing =

Edit

Figure 41 — Silencing Media Rule

The Media QoS settings are shown below.
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Media NAT || Media Encryption | | Media Anomaly | | Media Silencing | [Media QoS|

Media QoS Reporting
RTCP Enabled |

Media QoS Marking
Enabled

QoS Type DSCP

Audio QoS
Audio DSCP EF

Video QoS
Video DSCP EF

Figure 42 — QoS Media Rule

6.3.4. Create Security Rules

Security Rules allow one to define which enterprise-wide VolP and Instant Message (IM) security
features will be applied to a particular call flow. Security Rules allows one to configure
Authentication, Compliance, Fingerprinting, Scrubber, and Domain DoS. In addition to determining
which combination of security features are applied, one can also define the security feature profile,
so that the feature is applied in a specific manner to a specific situation.

For the compliance test, the predefined default-med security rule (shown below) was used for both
Avaya IP Office and the Windstream server.

From the menu on the left-hand side, select Domain Policies = Security Rules.
e Select the default-med Rule to view.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Security Rules: default-med
Administration [Filter By Device.. v
Backup/Restore "
Security Rules Itis not recommended to edit the defaults. Try cloning or.adding a new rule instead.
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Figure 43 - Security Rule
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6.3.5. Create Signaling Rules

Signaling Rules allow one to define the action to be taken (Allow, Block, Block with Response, etc.)
for each type of SIP-specific signaling request and response message. When SIP signaling packets
are received by the SBCE, they are parsed and “pattern matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

For the compliance test, the predefined default signaling rule (shown below) was used for both
Avaya IP Office and the Windstream server.

From the menu on the left-hand side, select Domain Policies = Signaling Rules.
e Select the default Rule to view.

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: default
Administration [Filter By Device v
Backup/Restore —
Signaling Rules Itis not recommended to edit the defaults. Try cloning or adding a new rule instead.
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Media Rules Optional Response Headers Allow
Security Rules
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Figure 44 - Signaling Rule

The Requests, Responses, Request Headers, Response Headers and UCID tabs have no entries.
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The Signaling QoS tab is shown below.

Alarms  Incidents ~ Statistics Logs  Diagnostics  Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: default
Administration [Filter By Device v
Backup/Restore —
System Management
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Edit
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Figure 45 — QoS Signaling Rule

6.3.6. Create Time of Day Rules

A Time-of-day (ToD) Rule allows one to determine when the domain policy which is assigned to
will be in effect. ToD Rules provide complete flexibility to fully accommodate the enterprise by, not
only determining when a particular domain policy will be in effect, but also to whom it will apply,
and for how long it will remain in effect.

For the compliance test, the predefined default Time of Day rule (shown below) was used for both
Avaya IP Office and the Windstream server.

From the menu on the left-hand side, select Domain Policies - Time of Day Rules.
e Select the default Rule to view.
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Edit
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Figure 46 — Time of Day Rule
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6.3.7. Create Endpoint Policy Groups

The End-Point Policy Group feature allows one to create Policy Sets and Policy Groups. A Policy
Set is an association of individual, SIP signaling-specific security policies (rule sets): application,
border, media, security, signaling, and ToD, each of which was created using the procedures
contained in the previous sections. A Policy Group is comprised of one or more Policy Sets. The
purpose of Policy Sets and Policy Groups is to increasingly aggregate and simplify the application of
SBCE security features to very specific types of SIP signaling messages traversing through the
enterprise.

From the menu on the left-hand side, select Domain Policies - End Point Policy Groups.
e Select Add
e Enter Group Name: IPO_14
- Application Rule: default
- Border Rule: default
- Media Rule: default_low_med
- Security Rule: default-med
- Signaling Rule: default
- Time of Day: default
e Select Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Policy Groups: IPO_14
Administration [Filter By Device.. v] [ Rename |[ Clone |[ Delete |
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Border Rules = default default default-low-med  default-med default default Edit Clone
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Signaling Rules avaya-def-low-enc
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Ipeoibay Rules avaya-def-high-subs...
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Groups avaya-def-high-server
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TLS Management

Figure 47 — Avaya IP Office End Point Policy Group

From the menu on the left-hand side, select Domain Policies = End Point Policy Groups.
e Select Add
e Enter Group Name: SP3
- Application Rule: default
- Border Rule: default
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- Media Rule: default-low-med
- Security Rule: default-med
- Signaling Rule: default

- Time of Day: default

e Select Finish (not shown).
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Figure 48 - Windstream End Point Policy Group
HV; Reviewed: Solution & Interoperability Test Lab Application Notes 46 of 59
SPOC 6/10/2014 ©2014 Avaya Inc. All Rights Reserved. WSIPO90SBCEG621




6.3.8. Create Session Policy

Session Policies allow users to define RTP media packet parameters such as codec types

(both audio and video) and codec matching priority. Together these media-related parameters define
a strict profile that is associated with other SIP-specific policies to determine how media packets
matching these criteria will be handled by the SBCE security product.

e From the menu on the left-hand side, select Domain Policies = Session Policies.
e Select the default policy
e Select Clone button
- Enter Clone Name: SP3
- Click Finish (not shown).
e Click Edit button on Media tab
- Check Media Anchoring
- Select Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Session Policies: SP3
Administration Add [Filter By Device V] \ Rename “| Clone m Delete ‘
Backup/Restore " -
System Management
etaul

Global Parameters Codec Prioritization H[

Global Profiles SP3

SIP Cluster iMedna Anchoring @|
4 Media Forking Profile None

Application Rules
4y Edit

Border Rules
Media Rules
Security Rules

Signaling Rules
Time of Day Rules

End Point Policy
Groups

Session Policies

TLS Management

Figure 49 - Windstream Session Policy — Anchoring Media
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6.4. Device Specific Settings

The Device Specific Settings feature for SIP allows one to view aggregate system information, and
manage various device-specific parameters which determine how a particular device will function
when deployed in the network. Specifically, one has the ability to define and administer various
device-specific protection features such as Message Sequence Analysis (MSA) functionality, end-
point and session call flows and Network Management.

6.4.1. Manage Network Settings

From the menu on the left-hand side, select Device Specific Settings = Network Management.
e Enter the IP Address and Gateway Address for both the Inside and the Outside interfaces:
- IP Address for Inside interface: 10.10.97.174; Gateway: 10.10.97.129
- IP Address for Outside interface: 10.10.98.106; Gateway: 10.10.98.97
e Select the physical interface used in the Interface column:
- Inside Interface: Al
- Outside Interface: B1

Alarms  Incidents  Statistics Logs  Diagnostics ~ Users Seftings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Network Management: mSBCE
Administration
Backup/Restore .
oo Contgureton] [RSHAES CoRRGMRSAER]
System Management |
mSBCE
Global Parameters Modifications or deletions of an IP address orits associated data require an application restart before taking effect: Application restarts can
Global Profiles be issued from System Management.
Domain Policies
A1 Netmask A2 Netmask B1 Netmask
TLS Management
4 [Device Specific Settings| Add [ save |
IP Address Public IP Gateway Interface
Management [10.10.97.174 IR | | [10.10.97.129 J| (A7 V]| Delete
Media Interface
Signaling Interface [10.10.98.106 Il [ | | [10:10.98.97 | {[B1 V|| Delete
Signaling Forking
Figure 50 - Network Management
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o Select the Interface Configuration Tab.
e Toggle the State of the physical interfaces being used to Enabled.

Alarms Incidents Statistics Logs Diagnostics Users

Session Border Controller for Enterprise

Settings Help Log Out

AVAYA

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
> Global Profiles
SIP Cluster
Domain Policies
TLS Management

4 |Device Specific Settings

Network Management: SBCE62

SBCEs2 Name Administrative Status

[a1 Enabled | Toggle

Network Configuration | |[interface Configuration]|

A2 Disabled Toggle

Enabled| Toggle

Disabled

Toggle

Network
Management

Media Interface

Figure 51 - Network Interface Status

6.4.2. Create Media Interfaces

Media Interfaces define the type of signaling on the ports. The default media port range on the

Avaya can be used for both inside and outside ports.

From the menu on the left-hand side, Device Specific Settings - Media Interface.
e Select Add
- Name: InsideMedia
- Media IP: 10.10.97.174 (Internal IP Address toward Avaya IP Office)
- Port Range: 35000 - 40000
- Click Finish (not shown)
e Select Add
- Name: OutsideMedia
- Media IP: 10.10.98.106 (External IP Address toward Windstream trunk)
- Port Range: 35000 - 40000
- Click Finish (not shown).

Seftings  Help

Log Out

Diagnostics  Users

Alarms  Incidents  Statistics Logs

Session Border Controller for Enterprise

> Global Parameters
Global Profiles
SIP Cluster
Domain Policies

AVAYA

Dashboard Media Interface: mSBCE
Administration
Backup/Restore .
[Modia merace |
System Management
mSBCE

from System Management.

Modifying or delefing an existing media interface will require an application restart before taking effect. Application restarts can be issued

Add

Name Media IP Port Range

TLSManagement: InsideMedia 10.10.97.174 35000 - 40000 Edit Delete

‘ Outsi 10.10.98.106 35000 - 40000 Edit Delete
etwork Management
Signaling Interface
Figure 52 - Media Interface
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6.4.3. Create Signaling Interfaces
Signaling Interfaces define the type of signaling on the ports.

From the menu on the left-hand side, select Device Specific Settings = Signaling Interface.
e Select Add
- Name: InsideSIP
- Media IP: 10.10.97.174 (Internal IP Address toward Avaya IP Office)
- UDP Port: 5060
- Click Finish (not shown).

From the menu on the left-hand side, select Device Specific Settings = Signaling Interface.
e Select Add
- Name: OutsideSIP
- Media IP: 10.10.98.106 (External IP Address toward Windstream trunk)
- UDP Port: 5060
- Click Finish (not shown).

Alarms  Incidents  Statistics Logs  Diagnostics  Users Settings Help Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Signaling Interface: mSBCE
Administration
Backup/Restore n
Signaling Interface
System Management
mSBCE
Global Parameters Add
Global Profiles Name Signaling IP TCP Port  UDP Port TLS Port TLS Profile
SIP Cluster InsideSIP 10.10.97.174 5060 - None Edit Delete
RomainFolicies OutsideSIP 10.10.98.106 5060 - None Edit Delete
TLS Management
4 | Device Specific Settings
Network Management
Media Interface
Signaling Interface

Signaling Forking

Figure 53 - Signaling Interface

6.4.4. Configuration Server Flows
Server Flows allow to categorize trunk-side signaling and to apply a policy.

6.4.4.1 Create End Point Flows — Windstream Flow

From the menu on the left-hand side, select Device Specific Settings - End Point Flows.
e Select the Server Flows tab
e Select Add, enter Flow Name: SP3 Flow
- Server Configuration: SP3
- URI Group: SP3
- Transport: *
- Remote Subnet: *
- Received Interface: InsideSIP

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 50 of 59
SPOC 6/10/2014 ©2014 Avaya Inc. All Rights Reserved. WSIPO90SBCE621



- Signaling Interface: OutsideSIP
- Media Interface: OutsideMedia

- End Point Policy Group: SP3

- Routing Profile: To_IPO_14

- Topology Hiding Profile: To_SP3
- Click Finish.

Add Flow

Flow Name [SP3 Flow

Server Configuration P3

URI Group P3

Transport

Remote Subnet

Received Interface
Signaling Interface
Media Interface

End Point Policy Group

nsideSIP v

OutsideSIP v

OutsideMedia v

P

Routing Profile

Topology Hiding Profile

File Transfer Profile

Figure 54 - End Point Flows 1

6.4.4.2 Create End Point Flows — Avaya IP Office Flow

From the menu on the left-hand side, select Device Specific Settings - End Point Flows.

e Select the Server Flows tab
e Select Add, enter Flow Name: IPO Flow
- Server Configuration: IPO_14
- URI Group: SP3
- Transport: *
- Remote Subnet: *
- Received Interface: OutsideSIP
- Signaling Interface: InsideSIP
- Media Interface: InsideMedia
- End Point Policy Group: IPO_14
- Routing Profile: To_SP3
- Topology Hiding Profile: To_IPO_14
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- Click Finish.

Add Flow

Flow Name [1PO Flow

Server Configuration IPO_14 v

URI Group SP3 v

Transport

Remote Subnet

Received Interface OutsideSIP v
Signaling Interface InsideSIP v
Media Interface nsideMedia

End Point Policy Group PO_14

Routing Profile To_SP3

Topology Hiding Profile To_IPO_14

File Transfer Profile None Vv

Figure 55 - End Point Flows 2

6.4.5. Create Session Flows

Session Flow determines the media (audio/video) sessions in order to apply the appropriate session
policy.
e Select Device Specific Settings from the menu on the left-hand side
e Select the Session Flows
e Select Add
e Enter Flow Name: SP3
- URI Group#1: SP3
- URI Group#2: SP3
- Session Policy: SP3

e Select Finish (not shown)
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Alarms  Incidents  Statistics Logs Diagnostics  Users Settings Help Log Out

Session Border Controller for Enterprise AVAYA

Dashboard Session Flows: SBCE62

Administration

Backup/Restore

System Management

> Global Parameters SRere
SIP Cluster
Domain Policies Priority Flow Name URI Group #1 URI Group #2 Su:1nel Su;znet Session Policy

> TLS Management

‘
Network Management
Media Interface
Signaling Interface
Signaling Forking
End Point Flows

Session Flows

Relay Services

SP3 Clone

Edit Delete

Figure 56 — Session Flows

7. Windstream SIP Trunking Configuration

Windstream is responsible for the configuration of Windstream SIP Trunk Service. The customer
must provide the IP address used to reach the SBCE at the enterprise. Windstream will provide the
customer the necessary information to configure the SIP connection between SBCE and
Windstream. The provided information from Windstream includes:

e Fully Qualified Domain Name, IP address and port number used for signaling or media

through any security.
e DID numbers.
e Windstream SIP trunking Specification.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 53 of 59
SPOC 6/10/2014 ©2014 Avaya Inc. All Rights Reserved. WSIPO90SBCE621



8. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State for each channel
(The below screen shot showed an active call at present time).

.5 Avaya IP Office System Status - IPOffice_1 (10.10.97.40) - IP500 V2 9.0.2.0 build 860 (=

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

- I3

Status | Utilization Summary Alarms
6) —
T SIP Trunk Summary
Line: 1 Peer Domain Name: 10.10.97.174
k Resolved Address: 10.10.97.174
A » Line Number: 17

e < Number of Administered Channels: 10

Vi | Number of Channels in Use: 2

=P a Administered Compression: G729 A, G711Mu

L Silence Suppression: Off
Layer 4 Protocol: uoP
SIP Trunk Channel Licenses: Unlimited . 1%
SIP Trunk Channel Licenses in Use: 2
SIP Device Features:
Channel URI CallRef CurrentState Timein State Remote Media Codec Connection Caller IDor  Other Party on Call Direction of Round Trip  Receive Jitter Receive Transmit Transmit
Number ddr v Dialed Digits call Delay Packet Los... Jitter Packet Los...
Connected 10.10.97.174 |G729A| RTPRelay | Extn 9306, 9306
Connected .10.97.174 |G711...| RTPRelay | 39675206... [Extn 9305, 9305 Incoming | 82ms
[ Trace ] [ Trace Al ] [ Pause ] [ Ping ] Call Details
Figure 57 — IP Office System Status
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

;i Avaya IP Office System Status - IPOffice_1 (10.10.97.40) - IP500 V2 9.0.2.0 build 860

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

K System
K & Alarms (7) Status  Utilization Summary Alarms
B Extensions (26) S—

Alarms for Line: 17 SIP 10.10.97.40

Error Description

Figure 58 — IP Office System Alarm

e Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.

e Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.
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9. Conclusion

Windstream SIP Trunking passed compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office, SBCE and the
Windstream SIP Trunk Service as shown in Figure 1.

10. Additional References

Avaya IP Office R9.0

[1] Avaya IP Office Document Library Release 9.0, Document number 15-604278 Issue 1,
September 2013

[2] Avaya IP Office 9.0 Installing IP500/IP500V2, Document number 15-601042 Issue 28g, 11
October 2013

[3] Avaya IP Office Manager Release 9.0, Document number 15-601011 Issue 9.01, 09 September,
2013

[4] Avaya IP Office 9.0 Softphone User Guide (Windows), Issue 07b, 19 August 2013

[5] Avaya IP Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-
604067 Issue 12f, 19 August 2013

Avaya Session Border Controller for Enterprise

[6] Avaya Session Border Controller for Enterprise Overview and Specification, Issue 2, December
2013

[7] Administering Avaya Session Border Controller for Enterprise, Release 6.2, Issue 2, January
2014

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.
XmMI&TEMPLATE=pdf feed template.html

Product documentation for Windstream SIP Trunking may be found at: http://www.windstream.com
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Appendix: SIP Line Template

Avaya IP Office Release 9.0.2 supports a SIP Line Template (in xml format) that can be created
from an existing configuration and imported into a new installation to simplify configuration
procedures as well as to reduce potential configuration errors.

Note that not all of the configuration information, particularly items relevant to specific installation
environment (e.g., the IP address assigned to the WAN interface of the IP Office, the service SIP
Proxy IP address provided by Windstream, etc.), is included in the SIP Line Template. Therefore it
is critical that the SIP Line configuration be verified/updated after a template has been imported, and
additional configuration be supplemented using Section 5.5 in these Application Notes as a
reference.
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To import the template into a new IP Office system, copy and paste the exported xml template file into the
Templates directory (C:\Program Files (x86)\Avaya\lP Office\Manager\Templates) on the PC where IP Office
Manager for the new system is running.

Next, import the template into the new IP Office system by creating a new SIP Line as shown in the
screenshot below. In the Navigation Pane on the left, right-click on Line then navigate to New - New SIP
Trunk From Template

IP Offices [= SIP Line - Line 17 ek - x| v«
- & BOOTP (5) SIP Line Transport | SIP URI|VolP 738 Fax|SIP Credentials
t-¢% Operator (3)
- IPOffice 1 Line Number 17 2
& Sy -
o[ [ New] » [ He23Line — @
211 ] Generate SIP Trunk Template IP DECT Line
< SIP Line
| % Cut Ctrl+X
SM Lis @
: Ny B3 Copy Ctrl+C ine Check 00S 2
o [ Ctrl 2P DECT Line Call Routing Method Request URI
:‘ f stte 3 New SIP Trunk From Template| | f Z
58 6 7<  Delete Ctrl+Del Originator number for
e s::  Validate forwarded and twinning calls
B Ser Connect To... Ctel+T Name Priority System Default v
oy RA! .
- Inc New from Templste (Binary) (Diversion Header <] CllerDrom From header 7]
@ Wa Export as Template (Binary) a
ou Directory ) ReSGeTston Methiod [By Source IP address v|  sendFromIn Clear ]
£ Time Profile (0) User-Agent and Server
i@ Firewall Profile (1) Headers
+- il IP Route (3)
@m Account Code (0) Service Busy Response 503 - Service Unavailable v
% License (30) . N
@& Tunnel (0) Action on CAC Location Limit | Allow Voicemail -
+-f3 User Rights (10) @
@ Auto Attendant (0) &2 REFER Support
- ARS (2) Incoming [Auto -
& Location (0)
Outgoing [Auto v]
Method for Session Refresh [Reinvite vl
Session Timer (seconds) 1200
Media Connection Preservation |Disabled -

On the next screen, Template Type Selection, verify that the information in the Country and Service
Provider fields is correct. If more than one template is present, use the drop-down menus to select the
required template. Click Create new SIP Trunk to finish the process.

' Template Type Selection

Locale
Corty | |
Service Provider | Windstream v | [ Display Al
LCreate new SIP TrunkJ [ Cancel J
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Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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